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Reakce na úkoly

Vesměs v pořádku

Ošetřenı́ výjimečných stavů

Datové struktury
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Pointery v C#

Velmi podobné jako v C a C++

Prakticky se moc nepoužı́vajı́ (je dobré o tom vědět)

Je potřeba explicitně řı́ci, že budeme použı́vat pointery – klı́čové slovo unsafe

Je potřeba kompilátoru předat /unsafe
VisualStudio – Project → Properties → Build → Allow unsafe code
Rider – Project → Properties → Configurations → Allow unsafe code

Použitı́ přı́ optimalizaci kódu (přı́klad – grafika - bitmapa)
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Operátory s pointery

Operátor Popis
* Vytvořenı́ pointeru, operátor dereference
& Zı́skánı́ adresy proměnné v paměti

->
Přı́stup k fieldům typu reprezentovaného pointerem
(unsafe verze . )

[] Indexovánı́ v pointeru
++, -- Inkrementace, dekrementace
+, - Sčı́tánı́, odečı́tánı́ pointerů
==, !=, <, >, <=, >= Porovnávánı́ pointerů
stackalloc Přı́mé alokovánı́ Pole na zásobnı́ku
fixed Dočasně zafixuje adresu pointeru (GC ji nezměnı́)
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Klı́čové slovo unsafe

Sloužı́ k vymezenı́ bloku, kde se bude pracovat s pointery

 unsafe {
 int cislo;
 int* pointerNaCislo = &cislo;
 *pointerNaCislo = 987;
 }


 unsafe struct Node { struct Node2 {
 public int Value; public int Value;
 public Node* Left; public unsafe Node2* Left;

 public Node* Right; public unsafe Node2* Right;
 } }

Value Node2 bude přı́stupná i mimo unsafe blok
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Fixed a moveable proměnné

Fixed (pevné, nemovité) proměnné – jejich adresu nezměnı́ garbage collector (GC)

Moveable (přesunutelné, movité) – GC je může přesunout či odmazat

Operátor & umı́ zı́skat adresu pouze fixed proměnné

Adresu moveable můžeme dočasně zafixovat pomocı́ klı́čového slova: fixed

Fixed proměnné jsou (zjednodušeně):
Lokálnı́ proměnné, hodnotové parametry metod
Proměnné vzniklé z member access – V.I, kde V je fixed struct
Hodnoty z dereference (*P), pointer member access (P->I) a pointer element access
(P[I])

Ukázka
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Alokovánı́ paměti na zásobnı́ku

Alokuje se přı́mo na callstacku, nezasahuje do nich GC

Klı́čové slovo stackalloc

 char* p = stackalloc char[256];
 for (int i=0; i<256; i++) {
 p[i] = (char)i;
 }


 for (int i = 0; i < 256; i++) {
 Console.WriteLine(p[i]);
 }
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Klı́čové slovo sizeof

sizeof() vrátı́ velikost internı́ho typu v paměti (v bajtech)

Mimo unsafe nefunguje pro uživatelsky definované typy

 Console.WriteLine($"Velikost shortu: {sizeof(short)}");
 Console.WriteLine($"Velikost intu: {sizeof(int)}");
 Console.WriteLine($"Velikost longu: {sizeof(long)}");
 Console.WriteLine($"Velikost floatu: {sizeof(float)}");
 Console.WriteLine($"Velikost doublu: {sizeof(double)}");
 unsafe {
 Console.WriteLine($"Velikost Node: {sizeof(Node)}");
 }
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Common Intermediate Language (CIL)

Veškeré ukázky budou pro jednoduchost provedeny ve starém .NET Frameworku

Pokud někdo nemáte Windows, můžete použı́t vzdálenou plochu na
ts.inf.upol.cz

V .NET možné také, horšı́ podpora (3rd party knihovny)
CIL kód již nenı́ ve .exe souboru ale v .dll
V .exe souboru je pouze platformově specifická ”obálka“, která načte kód z .dll

V Rideru k dispozici ILViewer
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Common Intermediate Language (CIL)
Common Intermediate Language (CIL) – internı́ jazyk platformy .NET

Všechny ostatnı́ jazyky se do něj kompilujı́

Komplexnı́ jazyk umožňujı́cı́ veškerou funkcionalitu (plná syntax, sémantika,
kompilátor)

Dobré znát pro optimalizace

Zásobnı́kový jazyk – PAPR2, slidy doc. Krupky:
https://apollo.inf.upol.cz/˜janostik/slides/papr2-11.pdf

Zkráceně: Operátory své argumenty hledajı́ vždy na vrcholu zásobnı́ku, odkud je
odeberou a zpracujı́

Na prvnı́ pohled podobný x86 assembleru

Operátory majı́ své (internı́) čı́selné kódy, ale i lidsky čitelné zkratky
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ildasm.exe – disassembler

Ve VisualStudiu si otevřeme Developer PowerShell (View→Terminal)

Spustı́me ildasm.exe cesta\k\exe

Objevı́ se nám dekompilované .exe s našı́m projektem

Můžeme si prohlı́žet zdrojový kód v CIL

 static void Main(string[] args) {
 int a = 6;
 int b = 36;
 int c = a + b;
 }

Se přeložı́ na:
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ildasm.exe – přeložený kód
.method private hidebysig static void Main(string[] args) cil managed {
.entrypoint
// Code size 11 (0xb)
.maxstack 2
.locals init ([0] int32 a,

[1] int32 b,
[2] int32 c)

IL_0000: nop
IL_0001: ldc.i4.6
IL_0002: stloc.0
IL_0003: ldc.i4.s 36
IL_0005: stloc.1
IL_0006: ldloc.0
IL_0007: ldloc.1
IL_0008: add
IL_0009: stloc.2
IL_000a: ret

} // end of method Program::Main

Radek Janoštı́k (Univerzita Palackého v Olomouci) Platforma .NET 2. 10. 2025 12 / 23

http://www.inf.upol.cz


Co vidı́me v kódu
CIL direktivy – tokeny popisujı́cı́ celkovou strukturu .NET sestavenı́

Začı́najı́ tečkou (např. .namespace, .class, . . .
Často vymezujı́ blok kódu (.namespace MujNamespace {}

CIL atributy – rozšiřujı́ jednotlivé direktivy
např.: public atribut u .class (viditelnost)
extends (dědičnost)

CIL Opcodes – Operačnı́ kódy, kódy operátorů, ale spı́še zkratky jmen
ldc.i4.6
stloc.0

Labels – nepovinné návěstı́, na které se dá odkazovat ve skoku
Dekompilátor automaticky doplňuje hexa čı́slo
IL_0000:, IL_000a:
Můžou být libovolné
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Co se děje v kódu (1/2)
.method private hidebysig static void Main(string[] args) cil managed {

Direktiva označujı́cı́ metodu, s atributy, jménem a seznamem argumentů

.entrypoint – vstupnı́ bod sestavenı́ – main

.maxstack 2 – řı́káme, kolik polı́ na zásobnı́ku použijeme (výchozı́: 8)

.locals init ([0] int32 a, [1] int32 b, [2] int32 c) – Deklarace
lokálnı́ch proměnných, musı́ být na začátku, čı́slováno od nuly.

V nestatické třı́dě je vždy nultým argumentem reference na aktuálnı́ objekt – this

IL_0000: nop – definice návěstı́ IL_0000 a operace ”Do Nothing“, ”No Operation“

Použita v Debug režimu, podpora breakpointů

IL_0001: ldc.i4.6 – Operace ”Push 6 onto the stack as int32“

IL_0002: stloc.0 – Operace ”Pop a value from stack into local variable 0“ – do
lokálnı́ proměnné a se vložil vrchol zásobnı́ku
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Co se děje v kódu (2/2)

IL_0003: ldc.i4.s 36 – Operace ”Push num onto the stack as int32, short form“
IL_0005: stloc.1 – Operace ”Pop a value from stack into local variable 1“ – do
lokálnı́ proměnné b se vložil vrchol zásobnı́ku
IL_0006: ldloc.0 – Operace ”Load local variable 0 onto stack“
IL_0007: ldloc.1 – Operace ”Load local variable 1 onto stack“ – načtenı́
operandů pro součet
IL_0008: add – Operace ”Add two values, returning a new value“ – na vrcholu
bude hodnota součtu
IL_0009: stloc.2 – Operace ”Pop a value from stack into local variable 2“ –
uloženı́ výsledku do c

IL_000a: ret – Operace ”Return from method, possibly with a value“

Radek Janoštı́k (Univerzita Palackého v Olomouci) Platforma .NET 2. 10. 2025 15 / 23

http://www.inf.upol.cz


Základnı́ operace

Opcodes Význam
add, sub, mul, div, rem Základnı́ aritmetické operace
and, or, not, xor Bitové operace
ceq, cgt, clt Porovnánı́ na rovnost, většı́ než, menšı́ než
ret Ukončenı́ metody, s návratovou hodnotou
beq, bgt, ble, blt operace pro větvenı́ programu: skoč na návěstı́ přı́padě rovnosti,

v přı́padě většı́ než, v přı́padě menšı́ rovno, v přı́padě menšı́ než
call Zavolánı́ metody
pop Odebere prvek ze zásobnı́ku
ldarg, ldstr Vložı́ argument metody na zásobnı́k, řetězec na zásobnı́k
starg, stloc Vložı́ vrchol zásobnı́ku do argumentu na indexu, lokálnı́ proměnné

Seznam operacı́ např. na
https://en.wikipedia.org/wiki/List_of_CIL_instructions
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Programovánı́ v CIL (1/3)
Otevřeme svůj oblı́bený textový editor
Vytvořı́me soubor test.il a můžeme začı́t programovat
Kostra:
.assembly extern mscorlib {
.publickeytoken = (B7 7A 5C 56 19 34 E0 89)
.ver 4:0:0:0
}

.assembly MujAssebly {

.ver 1:0:0:0
}

.namespace MujCilSpace {
.class public MyClass {
.method private hidebysig static void Main(string[] args) cil managed {
.entrypoint
.maxstack 8
// Tady můžeme programovat

}
}

}
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Programovánı́ v CIL (2/3)

Zjištěnı́ public key knihovny:
> sn.exe /T "C:\Program Files (x86)\Reference Assemblies\Microsoft\Framework\.NETFramework\v4.7.2\System.Core.dll"
Microsoft (R) .NET Framework Strong Name Utility Version 4.0.30319.0
Copyright (c) Microsoft Corporation. All rights reserved.
Public key token is b77a5c561934e089

Kompilace:
> ilasm.exe /exe .\test.il /output=Program.exe
Microsoft (R) .NET Framework IL Assembler. Version 4.7.3190.0
Copyright (c) Microsoft Corporation. All rights reserved.
Assembling ’.\test.il’ to EXE --> ’Program.exe’
Source file is UTF-8
Assembled method MujCilSpace.MyClass::Main
Creating PE file
Emitting classes:
Class 1: MujCilSpace.MyClass
Emitting fields and methods:
Global
Class 1 Methods: 1;
Emitting events and properties:
Global
Class 1
Writing PE file
Operation completed successfully
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Programovánı́ v CIL (3/3)
ilasm.exe je pouze kompilátor, nekontroluje význam operacı́
Nekontroluje, zda je na konci volánı́ funkce prázdný zásobnı́k
Naštěstı́ máme nástroj peverify.exe, který toto umı́ zkontrolovat
> ilasm.exe /exe .\test.il /output=Program1.exe
... Emitting events and properties:
Global
Writing PE file
Operation completed successfully

> PEVerify.exe .\Program1.exe

Microsoft (R) .NET Framework PE Verifier. Version 4.0.30319.0
Copyright (c) Microsoft Corporation. All rights reserved.

[IL]: Error: [C:\Users\janora01\source\repos\CIL\CIL\Program1.exe :
MujCilSpace.MyClass::Main][offset 0x0000000B] Unable to resolve token.

[IL]: Error: [C:\Users\janora01\source\repos\CIL\CIL\Program1.exe :
MujCilSpace.MyClass::JumpTest][offset 0x0000001A] Stack underflow.

2 Error(s) Verifying .\Program1.exe
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CIL – volánı́ metod

Argumenty nejdřı́ve uložı́me na zásobnı́k

Poté můžeme využı́t operaci call

Musı́me uvést celou cestu k metodě + assembly

Ukázka
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CIL – větvenı́

Větvenı́ umožněno pomocı́ operacı́ se skokem. Přı́klad:

blt IL_0009 – porovná dvě hodnoty na zásobnı́ku a pokud je prvnı́ menšı́ než
druhá, skočı́ na návěstı́ blt IL_0009

Takto můžeme implementovat cykly (vzpomeňte na x86 assembler)

Operace br – ”Branch to target“ skáče bez podmı́nky
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Závěr

Na tomto semináři CIL probrán pouze ”letmo“

Doporučuji si k tomu přečı́st kapitoly v doporučené literatuře

Neprobrána spousta věcı́
Datové typy
Práce s třı́dami, Interface, dědičnost, properties
. . .

Pouze abychom měli trochu tušenı́, co se děje ”pod kapotou“
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Úkol

1 V C# naprogramujte Euklidův algoritmus pro zjištěnı́ největšı́ho společného dělitele
Zjistěte jeho CIL kód
Řádek po řádku okomentujte, co se děje

2 Bez spuštěnı́ zjistěte co dělá kód v souboru
https://apollo.inf.upol.cz/˜janostik/code/MysteriousMethod.il

3 V CIL naprogramujte metodu, která vypočı́tá diskriminant kvadratické rovnice

4 V CIL naprogramujte metodu FizzBuzz(int limit), která:
Vypı́še čı́sla od 1 do limit
Je-li čı́slo dělitelné 3 bude nahrazeno řetězcem ”Fizz“ a
Je-li čı́slo dělitelné 5 bude nahrazeno řetězcem ”Buzz“
Vı́ce na: https://en.wikipedia.org/wiki/Fizz_buzz
Přı́klad: 1, 2, Fizz, 4, Buzz, Fizz, 7, 8, Fizz, Buzz, 11, Fizz, 13, 14, Fizz Buzz, 16, 17, Fizz, 19, Buzz,
Fizz, 22, 23, Fizz, Buzz, 26, Fizz, 28, 29, Fizz Buzz, 31, 32, Fizz, 34, Buzz, Fizz, ...
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